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Installing KNIME Analytics Platform


For step-by-step videos on how to install KNIME Analytics Platform, please take

a look at our KNIMETV YouTube channel.

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.
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Figure 1. KNIME Analytics Platform versions

4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

 Also check the KNIME Quickstart Guide and the KNIME Workbench Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions by:

• Clicking File on the menu bar and then Install KNIME Extensions…. The dialog shown in

Figure 2 opens.

• Selecting the extensions you want to install

• Clicking "Next" and following the instructions

• Restarting KNIME Analytics Platform
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Figure 2. Installing Extensions and Integrations

The Install KNIME Extensions menu provides the extensions that are available via the update

sites you have enabled.


For more information, take a look at our video on How to Install Extensions in

KNIME Analytics Platform. Also see the Extensions and Integrations Guide.
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking File → Update KNIME…. In the dialog that opens, select the available updates

you want to install and then click Next.

2. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, select File → Preferences →
Install/Update → Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 3. Available Update Sites

KNIME Analytics Platform 4.0 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Extensions: Provides

extensions created by KNIME partners.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Analytics Platform 4.0 Update Site and KNIME Community Extensions (Trusted) are

enabled by default.
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Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 4.

Figure 4. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file. You can download KNIME update sites

as zip files here.

• Save the zip file containing the extensions to your local system

• Select File → Preferences → Install/Update → Available Software Sites and enter the

path to the zip file by clicking Add → Archive… as shown in Figure 5.
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Figure 5. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable the

update site by disabling it in the list.

• Now click Apply and Close



If the same extensions are also provided by a remote update site, you will first

have to disable that update site by deselecting its entry in the Available

Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Changelog (KNIME Analytics Platform 4.0)

Detailed changelog for v4.0.x releases

KNIME Analytics Platform 4.0.0

(see highlight summary)

Release date: June 27, 2019

New Nodes

• AP-11517: Split Quickforms into Configuration and Wizard Nodes

• AP-12154: Plotly Visualization Extension (12 new visualization nodes using

plotly.js — Radar Plot, 3D scatter plot, error bars plot, bubble chart, etc.)

• AP-11848: Amazon Authenticator

• AP-11755: Integration of AWS Machine Learning Services

• AP-11721: SHAP Loop (loop construct for determining feature importance for individual

predictions)

• AP-11594: LIME Loop Start (performs sampling for Local Interpretable Model-agnostic

Explanations)

• AP-11471: DL: Create Executors for different backends

• AP-10983: Container Input (Row)

• AP-11319: Container Output (Row)

• AP-11292: ONNX to TensorFlow converter node

• AP-11071: T-SNE Node (popular dimensionality reduction technique)

• AP-10903: H2O Isolation Forest (anomaly detection based on H2O Isolation Forest)

• AP-10674: LDA Apply

• AP-10214: Text Mining: Unique Term Extractor node

• AP-9901: Duplicate Row Filter

• AP-9852: JS Partial Dependence and ICE View (visualizes feature impacts on model

predictions)

• AP-9486: Document Viewer (JavaScript)

KNIME Analytics Platform Installation Guide

© 2018 KNIME AG. All rights reserved. 11

https://www.knime.com/whats-new-in-knime-40


• AP-9485: Text Processing: Brat Document Writer

• AP-9272: DB Loader

• AP-8687: Value Filter Definition Quickform node

• AP-6993: Text Mining: Relation triplet extractor

• BD-866 / BD-867 / BD-870: (Big Data Extensions): Spark Decision Tree/Random

Forest/Gradient Boosted Trees Learner (based on Spark ML)

• BD-914: (Big Data Extensions): Spark Predictor (Classification)

• BD-926 / BD-927 / BD-928: (Big Data Extensions): Spark Decision Tree/Gradient

Boosted Trees/Random Forest Learner (Regression)

• BD-929: (Big Data Extensions): Spark Predictor (Regression)

• BD-882: (Big Data Extensions): Create Local Big Data Environment (new)

• BD-747: (Big Data Extensions): DB to Spark (new)

• BD-746: (Big Data Extensions): Spark to DB (new)

• BD-745: (Big Data Extensions): Spark to Impala (new)

• BD-744: (Big Data Extensions): Spark to Hive (new)

• BD-743: (Big Data Extensions): Hive to Spark (new)

• BD-742: (Big Data Extensions): Impala to Spark (new)

• BD-737: (Big Data Extensions): Impala Connector (new)

• BD-736: (Big Data Extensions): Hive Connector (new)

• BD-335: (Big Data Extensions): Spark Repartition

Enhancements

• AP-12059: Update Infocom/ChemAxon extension to 4.0.0.v191300

• AP-12032: Layout Editor: Quickform should be replaced with Wizard node

• AP-11999: Prevent stop-the-world garbage collection when adding rows to buffer

• AP-11931: Redesign Welcome Page

• AP-11913: Improve error message for ONNX to TensorFlow Network Converter node

• AP-11879: Tableau Server: Add support for authentication via API token

• AP-11858: Revisit Garbage Collection in KNIME

• AP-11852: Enable asynchronous writing of tables to disk at loop end nodes
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• AP-11851: Add suggestion in Windows installer to add KNIME AP as an exception for

Windows Defender

• AP-11814: Action to open linked components in the browser from AP

• AP-11788: Link (and update) templates/components when dragged and dropped from

browser

• AP-11777: Provide Plotly example templates for the Generic JS view

• AP-11773: Parameter Optimization Loop: Bayesian Optimization with Tree-structured

Parzen Estimator (TPE)

• AP-11769: Add option for a custom error message to Breakpoint

• AP-11767: Add MAPE error metric to the Numeric Scorer

• AP-11764: Improve error message display of Wrapped Metanodes

• AP-11763: Enable templates in Generic JS View

• AP-11738: Search View for Hub

• AP-11733: Retire Wrapped Metanodes; Introduce "Components"

• AP-11722: DevDoc: Add .qualifier to version number in NumberFormatter Example

• AP-11713: Various workflowalizer improvements

• AP-11701: Keras: Add causal as padding option for Conv1D

• AP-11650: Kafka Producer: Add option to send records asynchronously

• AP-11635: Support sending of JDBC parameter via JDBC url and not only properties file

• AP-11628: Improve workflow metadata editing

• AP-11575: Tweak dictionary page size for Parquet Table Store

• AP-11424: Shapley Values Loop (loop construct to determine feature importance for

individual predictions)

• AP-11365: Prevent unnecessary db query execution between configure and execute

• AP-11336: Support the extended character limit also for Retweets

• AP-11334: Implement a sliding window cache table

• AP-11277: CSV Writer with option to write numbers in scientific notation (default was:

scientific but will be non-scientific now)

• AP-11244: Upgrade Java Version (from Oracle JRE 1.8.0_152 to OpenJDK 8u202-b08)

• AP-11221: Add support in S3 node for switching roles

• AP-11217: Unit-Test-based Performance Benchmarking Suite for KNIME Core

• AP-11202: Move domain update into separate thread
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• AP-11191: Remove Warning "Table has k rows, ignored all rows except the first one"

from Table row to variable node

• AP-11165: Less verbose logging in knime.log file and KNIME console ("WARN" as new

default minimum level) — speed-up for logging intensive workflows, e.g. using loops

• AP-11091: Replace GZIP compression of KNIME tables with speed-optimized algorithm

• AP-11076: Revise Kerberos preference page

• AP-11044: Tensor Processing: Explicitly handle forks in graph during execution

• AP-11008: Veto annotation selection when clicking out of content edit mode

• AP-10887: Start annotation content edit in annotation editing mode by single-click on

selected annotation

• AP-10871: Text Mining: Meta Info Extractor to fit to new Meta Info Inserter

• AP-10870: Text Mining: Meta Info Inserter to add multiple meta information

• AP-10848: Add VirtualTensorOpSpecs for all "Views." operations from ImgLib

• AP-10844: Allow FileStoreCells referencing zero FileStores

• AP-10685: Internal data handling: Optimize asynchronous table write

• AP-10684: Optimize when and how to write tables to disk

• AP-10682: Text Mining: Add option for case sensitivity for StanfordNLP NE Learner

• AP-10546: Image Processing: LabelingValue and Cells

• AP-10534: DL Framework: Support String inputs

• AP-10499: Text Mining: Improve preprocessing nodes that use regex

• AP-10367: Random Strategy for Feature Selection

• AP-10340: Genetic Algorithm for Feature Selection

• AP-10215: Text Mining: Option for Dict Replacer (2 inports) to replace terms with

default value that are not included in dictionary

• AP-10205: Column-based storage: Row iterator for range of rows

• AP-10139: Extract Date&Time Fields: Add option to extract the week-based year

• AP-10082: Refactor LDA Node

• AP-9903: Range slider should be able to fix one of the 2 ends so you filter by just

moving lower or upper bound.

• AP-9606: Dropping file from Explorer should mimic node-from-Node-Repository drop

behavior

• AP-9574: Enable focus traversal in node dialogs (via TAB, SHIFT-TAB, CTRL-TAB and

CTRL-SHIFT-TAB)
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• AP-9479: REST Client Nodes (GET, POST, …) support NTLM authentication

• AP-9129: Complement context menu settings with toolbar for annotations

• AP-8904: DL Framework: Deprecation mechanism for converters

• AP-8505: DL Python: Preference page

• AP-8465: Python: Better error message if arrow is not installed or installed in a wrong

version

• AP-8433: Python Installation: Make it easier to setup KNIME Python

• AP-8308: DL: Allow to select used CPU/GPU in DL nodes

• AP-7816: Text Mining: constructor of Author class must not set different name values

other than given parameters

• AP-7019: Support knime URLs for 'Binary Objects to Files'

• AP-5943: Add encoding options to SDF Reader and Writer

• AP-5320: Google Analytics Query Node - Improved segments support (migrate to new

dynamic segments API, add advanced segments support)

• AP-5087: Number to String and String to Number (with and without PMML) with new

column filter panel ("enforce in/exclusion")

• BD-336: (Big Data Extensions): Show number of partitions in tooltip and view of Spark

data output ports

• BD-909: (Big Data Extensions): Remove license check on KNIME Server for

Parquet/ORC Reader and Writer nodes

• BD-740 (Big Data Extensions): Hive support for DB Loader

• BD-741 (Big Data Extensions): Impala support for DB Loader

• BD-795: (Big Data Extensions): Code completion in PySpark nodes

Bug Fixes

• AP-11998: OSM nodes: Default Open Street Map Tile-Server not available anymore

• AP-11994: "Quick jump to function" does not work properly for String

Manipulation/Math Formula

• AP-11920: Expression syntax check broken in some nodes

• AP-11285: Failed attempt to create multiple SWT Displays

• AP-12073: Dynamic Node Generation Framework logs Error for SVG outport, even if

SVG image is not output.
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• AP-12068: Can’t use "Configuration" and "Widget" nodes in a sequence

• AP-12036: Window for Shared Components Link Type still references "Metanode

Template"

• AP-12002: Deadlock when opening a workflow with an executed node that wants to

access the flow variables via NodeModel.getAvailableInputFlowVariables() in

NodeModel.loadInternals()

• AP-11992: Wrong Message when Dragging’n’dropping components from browser (hub)

to AP workbench

• AP-11961: Reading and Writing BLOB/Binary object columns doesn’t work for various

databases

• AP-11950: Allow to select no constant column in Feature Selection Loop Start nodes

• AP-11917: PCA Apply node doesn’t execute if number of dimensions > number of input

columns even if the number of dimensions selection is disabled

• AP-11882: Sharing Components whose name contains trailing spaces fails

• AP-11877: Python: Nodes not printing to dialog console

• AP-11867: H2O Integration: MOJO Reader kills JVM if the MOJO is overwritten during

reading

• AP-11854: DoubleCell hashCode not compatible with equals for 0.0 and -0.0

• AP-11836: Location of File in Excel Reader cannot be controlled via FlowVariable

• AP-11798: Example workflows in LOCAL contain deprecated nodes

• AP-11784: H2O Integration: Rename H2O Regression Scorer to H2O Numeric Scorer

• AP-11783: H2O Integration: MOJO predictors don’t set warnings about missing

columns during execution

• AP-11780: Workflow Migration Tool throws NullPointerException when migrating nodes

with lazily initailized NodeFactories

• AP-11778: Workflow Migration Tool "swallows" unconnected ports of metanodes

• AP-11758: Container Output (JSON) always takes first column to fill example

• AP-11752: Expression Engine: Cannot return collections

• AP-11747: Buffer flusher persists beyond workflow execution

• AP-11744: Forward compatibility: Enable the loading of workflows saved with snappy-

compressed data in pre-3.8.0 KNIME AP

• AP-11725: H2O Integration: Rework Generalized Linear Model Learner dialog

• AP-11710: Resetting Wrapped Metanode keeps successors in queued state
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• AP-11705: Favorite Nodes View: Most frequently and last used nodes won’t get

updated when nodes are dragged and dropped

• AP-11667: Breakpoint node remains active even if in inactive branch

• AP-11655: Database Driver window missing Dialog buttons on Linux

• AP-11649: XLS Writer throws IOException when writing to knime protocol and file does

not exist.

• AP-11581: H2O Integration: Ports of H2O scorer nodes are reversely ordered

• AP-11574: Editing node annotations results in poor performance / UX

• AP-11572: PCA Node Doesn’t Always Reduce Dimensions Properly

• AP-11532: Bad error message when Table Reader is unable to read .table file written

with Parquet extension (but extension is not installed)

• AP-11494: Tableau Preferences panel error with only Hyper nodes/sdk installed

• AP-11485: Prediction Fusion: Improve description of minimum and maximum method

• AP-11483: (Linux only) Entering annotation edit mode changes background of other

view components in KNIME UI

• AP-11477: SSH Connection Does Not Resolve Non-Existing Path Correctly

• AP-11469: Rule Engine nodes - unclear description regarding comments

• AP-11464: Missing Value node: Loading missing cell handlers causes

ConcurrentModificationException

• AP-11463: DL Keras Layer nodes allow white spaces in names but they do not work

• AP-11462: Template link type cannot be updated from component

• AP-11449: Options Use full path and Truncate prefix in Upload node not working

correctly

• AP-11443: Edit Nominal Domain doesn’t show domain values in dialog on re-open

• AP-11436: Container Input (Row) populates swagger example in wrong format

• AP-11433: Port Objects are not copied in Streaming Mode

• AP-11430: Unclear error message in the Container Input (Row) node

• AP-11421: XGBoost: Fix dialog loading issue in learners

• AP-11411: Renderer to Image: NPE on first dialog

• AP-11402: H2O Integration: Rework Random Forest and Gradient Boosting Machine

dialogs

• AP-11381: Multiple Scroll bars in JavaScript Views

KNIME Analytics Platform Installation Guide

© 2018 KNIME AG. All rights reserved. 17



• AP-11379: Excel Writer and Excel Sheet Appender automatically add xlsx, after xlsm

• AP-11375: Renaming workflow with open report yields to lock on workflow

• AP-11353: Interval Loop Start outputs rounding errors

• AP-11327: Typo in "Category To Number" node description

• AP-11276: Communication between Chromium browser window and Java sometimes

'hangs'

• AP-11245: Source directory structure not deleted in KNIME Explorer when moving (and

merging) directories

• AP-11211: Typo in regexReplace function in String Manipulation and Column

Expressions

• AP-11208: DatabaseSession creation blocks workflow loading if db is not reachable

• AP-11204: Potential race condition when canceling an executing node

• AP-11201: JSON Path: table in configuration dialog not updating on macOS

• AP-11196: Wait node ignores existing files

• AP-11180: Extract Context Properties throws IlegalArgumentException in newly created

workflows

• AP-11178: Connections of MongoDB Nodes are not closed

• AP-11170: JSON Reader: fails for UTF-8 encoded file with BOM

• AP-11169: Corrupted display when creating a component

• AP-11164: Java Snippet nodes: Expressions get unnecessarily re-compiled during

configuration — makes fast executing loops much slower (factor 10-100)

• AP-11139: "Reference Column Resorter" fails when reference table contains unknown

values

• AP-10989: DL Python Network Creator can’t create network with tf.string input/output

• AP-10972: Jsonpath does not generate missing values for string columns

• AP-10888: Gradient Boosted Trees to PMML produces invalid PMML

• AP-10812: H2O Predictor (Classification) probability column names differ from other

predictor nodes

• AP-10532: DL TensorFlow: Reader: Tensor doesn’t appear in ouputs drop-down of

advanced settings

• AP-10515: Text editor auto-completion is buggy on Windows, crashes on Mac

• AP-10513: Stacked Area Chart does not respond to filters on excluded columns
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• AP-10471: DB SQL Executor accepts an empty SQL statement

• AP-10411: Drag & drop files to KNIME Explorer stops working

• AP-10199: Data Explorer nodes refers incorrectly to nominal columns charts as

"histograms"

• AP-7020: (Database) GroupBy node produces duplicate columns when doing Type

Based aggregation

• AP-6588: Problems with Linear Discriminant Analysis Node

• AP-1590: NodeLogger isDebugEnabled always returns true

• BD-921: (Big Data Extensions): Spark to Hive on HDP 3.1 fails when writing to non-

default DB

• BD-916: (Big Data Extensions): Parquet writer can be run with empty filename

• BD-912: (Big Data Extensions): Parquet Reader nodes fail when executed in parallel

• BD-898: (Big Data Extensions): Orc/Parquet reader fail to read from remote filesystems

in streaming mode

• BD-894: (Big Data Extensions): Parquet and ORC Reader fail to read from Kerberos-

secured HDFS

• BD-824: (Big Data Extensions): Parquet/ORC Reader/Writer Type mapping entry

missing in node description

• BD-812: (Big Data Extensions): ORC Reader should handle type conversion failures

more gracefully

• BD-810: (Big Data Extensions): Spark to Parquet/ORC doesn’t exclude all columns in

Partitions Tab if the spec changes

• BD-180: (Big Data Extensions): HttpFS Connection node does not report on errors

properly

KNIME Analytics Platform 4.0.1

Release date: August 15, 2019

Enhancements

• AP-12371: Display technical JDBC driver ID together with human-readable driver name

• AP-12119: Copy&Paste of workflow from Hub

• AP-12114: Allow to disable DB transactions
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• AP-12001: UI improvements to the metadata editor

Bug Fixes

• AP-12458: Dragging on a shared component containing a credentials configuration

from remote freezes KNIME

• AP-12398: Master Page panel in BIRT is inaccessible (greyed out)

• AP-12357: Order of possible values produced by File Reader is non-deterministic

• AP-12341: Excel Reader - More Options dialog grayed out

• AP-12239: Joiner node with empty table in top port generates

ArrayIndexOutOfBoundsException in 4.0.0

• AP-12238: KNIME 4.0 ignores logging information from any class except

{org|com}.knime.* (breaks log messaging from partner extensions)

• AP-12198: Chromium 75 update causes error modals to automatically close

• AP-12159: AP does not prompt for initial workspace location on first startup

• BD-950: (Big Data Extensions): Create Spark Context (Livy) fails with

UnsupportedOperationException when using S3 Connection as file system

• AP-12545: Endless update of annotation data if workflow is set dirty

• AP-12542: Opening workspace created with AP 3.5 yields nullpointer

• AP-12525: Violin Plot View fails with JS error if "Skip Rows with missing values" is

selected

• AP-12510: SHAP Loop Start can get stuck in sampling loop

• AP-12501: DB Loader fails if Hive or Impala table does not exist during configure

• AP-12496: Send to Tableau Server (Hyper): Cannot set project id

• AP-12494: Improve the validation mechanism of database connector nodes

• AP-12484: XGBoost Predictor can’t deal with different column orders

• AP-12478: R: Error logged: Error reading output of R process

• AP-12470: SSH Connection does not correctly handle remote knime:// URLs for private

key

• AP-12459: DeepLearning4J: Settings loading dependent on locale

• AP-12451: Hive/Impala Loader fails if default schema is read-only

• AP-12373: Prevent registering JDBC drivers with built-in driver IDs/names

• AP-12369: DB driver URL template should be used by all dedicated DB connector nodes
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when driver is selected

• AP-12364: DB connection context property resolution does not work with Kerberos

• AP-12333: Cannot move/copy and overwrite multiple workflows in KNIME Explorer

• AP-12329: Parameterized DB Query Reader fails if the same column name is used

multiple times in the query

• AP-12282: Data files getting overwritten without being asked when drag’n’dropped or

copied&pasted into explorer

• AP-12275: Range Slider Filter node outputs rounding erros

• AP-12270: H2O Integration: Add validation setting to GLM to fix lambda search

• AP-12242: H2O Integration: Partitioning and missing value imputation may change the

column types

• AP-12232: KNIME Hub cannot be removed via preferences

• AP-12225: Metanode/component port migration errors

• AP-12223: Violin Plot fixes

• AP-12221: Bubble Chart node displays different bubble size if group-by column is

provided

• AP-12220: Drag’n’drop problem with Image Processing nodes from Hub to AP

• AP-12216: When clicking "deploy to server" while the server is still fetching the view will

never update

• AP-12209: Plotly (Scatter Plot) no data in image when using OpenGL library

• AP-12207: List Remote Files can’t handle knime:// protocol with whitespaces

• AP-12201: Variable Expressions shows wrong label for the evaluation

• AP-12200: H2O Generalized Linear Model Learner nodes fail if lambda = 0

• AP-12197: Component not found on Hub even though it exists

• AP-12181: Metanode dialogs refer in disclaimer text to 'quickforms' and

'components' — they shouldn’t.

• AP-12180: Plotly Bubble Plot: leaving title blank still results in a default title being

displayed

• AP-12179: Divide by zero error in Statistics node

• AP-12164: Starting KNIME AP on Windows with new workspace yields all mount points

fully expanded

• AP-12162: Fix Plotly suggested extension or update how nodes are registered with their

extensions
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• AP-12161: File Upload Widget does not behave like File Upload

• AP-12160: Upload node truncate prefix function does not work for prefixes containing

whitespaces

• AP-12157: Component referred to as Meta Node when sharing of template fails

• AP-12147: Document Grabber Node gives n-1 documents

• AP-12101: Table View: Multiple Scroll bars

• AP-12100: Pie/Donut Chart: Multiple Scroll bars

• AP-12099: Tagged Document Viewer: Multiple Scroll bars

• AP-12097: PDP Obsolete Axis Title Settings

• AP-12095: Node Description PDP/ICE node does not describes correctly input ports

• AP-12093: PDP/ICE node description should reference a soon to be published Hub

example workflow

• AP-12061: Naming and description of Out-of-Bag Port of Tree Ensemble and Random

Forest learners is confusing

• AP-12060: Plotly nodes: Create legend group for missing values

• AP-12047: Table Validator typo in error message "CONVERTION"

• AP-11990: Jumping workflow when editing node annotation

• AP-11567: RServe instances dies during execution

• AP-11310: Credential Input nodes always use first workflow credential if multiple

credentials are available

• AP-11224: Explorer: Error while moving directory to parent directory

• AP-11150: Components: inconsistent tab-title and node annotation

• AP-7245: Gradient Boosted Tree ArrayIndexOutOfBounds problem

• AP-6372: Parallel Chunk loop with large parallelization and nested scopes might error

with: "Too many nested loops: 128"

• BD-957: (Big Data Extensions): Create Local Big Data Environment should always use

the built in driver

• BD-956: (Big Data Extensions): Parquet Reader’s type by name mapping dialog does not

work

• BD-955: (Big Data Extensions): Parquet Reader/Writer should support Parquet types

ENUM, JSON, INT8/16/32/64, TIME_MICROS and TIMESTAMP_MICROS

• BD-951: (Big Data Extensions): Spark Job Server Job Controller fails on job result

deserialization with tmp file exists
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• BD-942: (Big Data Extensions): PySpark nodes only update FlowVariables if Dialog is

opened

• BD-938: (Big Data Extensions): DB Loader with Impala fails to upload tables with

LocalDate(Time) columns

• BD-937: (Big Data Extensions): DB Loader with Hive fails on CDH 6 with

ArrayIndexOutOfBoundsException

• BD-936: (Big Data Extensions): DB Port of Create Local Big Data Environment node fails

to load when opening an already executed workflow

• BD-935: (Big Data Extensions): PySpark configuration dialog does not open due to

NullPointerException when Spark 1.x is chosen in Spark preferences

KNIME Analytics Platform 4.0.2

Release date: October 1, 2019

Enhancements

• AP-12603: Jaro Winkler Distance for Similarity calculation

• AP-12593: Improve performance of Math Formula (Multi Column)

• AP-12080: Automatically install missing extensions after component drag and drop

Bug Fixes

• AP-12685: Filter definition not applied in Range Slider Filter Definition node

• AP-12799: Fix performance problems with DB framework

• AP-12764: Dictionary Tagger (Multi Column) does not tag correctly when using >1

parallel threads

• AP-12725: Tile View and Tagged Document Viewer do not work with IE11

• AP-12709: Reduce memory footprint of Reference Row Filter Node

• AP-12692: Resizing of Tagged Document Viewer is not working

• AP-12672: Text Mining: Unique Term Extractor counts sentence frequency instead of

document frequency

• AP-12640: Dialog of String Distances cannot be opened if Distance Measure does not

exist
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• AP-12612: Disallow overwriting files in KNIME Explorer with files of different type

• AP-12599: Credentials Widget fails when initially put into the workflow

• AP-12562: Date&Time Widget: Next button in WebPortal not working

• AP-12546: DecisionTreeViews can throw NPE

• AP-12536: SHAP and Shapley Values loop end fail with uninformative error if no

prediction column is chosen

• AP-12518: Violin plot node does not accept two or more interactive filter definitions

• AP-12517: Document Tagger Viewer: Shows words/ letters as tagged, which aren’t.

• AP-12515: New database feature added to knime-ap target platform

• AP-12509: PDP / ICE view is not responsive in composite view and it ignores custom

pixel sizes of layout panel

• AP-12502: H2O Integration: Table to H2O ignores nominal columns with invalid

domains without any warnings

• AP-12481: 'Rule Engine Variable' gives wrong results if input variable is overwritten

• AP-12472: Decision Tree View doesn’t open for Random Forest Trees

• AP-12288: Plotly nodes are not reacting to nominal filter events

• AP-12196: Tagged Document Viewer: "Show title in document"squeezes inner title on

Windows

• AP-11269: Executed Keras Input Layer doesn’t work after upload and download from

server

• AP-10694: Right clicking node annotation shows z-order menu

• AP-10416: Write only status information in DB Manipulation nodes

• AP-6266: Decision Tree Learner fails on RootSplitColumn without domain values

• BD-973: (Big Data Extensions): Create Spark Context (Livy) fails with exception if

spark.ui.enabled is false
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